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We'll begin with a box , and the plural is boxes; But the plural of ox  became oxen not oxes.  One fowl is a goose, 
but two are cal led geese, Y et the plural of moose should never be meese.  

Microsoft buys Teleo to 
boost VoIP services 
Technology w ill be incorporated 
into MSN Messenger 
Robert Jaques, Vnnunet 31 Aug 2005  
 

M icrosoftttoday announced that it 
has acquired Teleo, a VoIP pro-
vider which has developed 

technology to enable the placement of 
PC phone calls to traditional phones.  
Financial details of the acquisition were 
not disclosed. 
 

The Redmond giant said that it will use 
Teleo's technology to extend its existing 
VoIP services. 
VoIP technology is already featured in 
MSN Messenger as well as other Micro-
soft products and services. 
 

Microsoft plans to incorporate and 
expand on Teleo's technologies, 
integrating them into the infra-
structure that supports MSN and 
ultimately " delivering new VoIP 
consumer applications in future 

releases of MSN services".  
 

Founded in 2003 and headquartered in 
San Francisco, Teleo is a privately held 
company. 
 

Through its integration with Microsoft 
Outlook and Internet Explorer, Teleo's 
service was designed to facilitate click-to-
call dialling of any telephone number that 
appears on-screen, for example through 
a website or via search results or email. 
 

 
(Continued on page 2) 
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Y ou may find a lone mouse or a nest full  of mice; Y et the plural of house is houses,  not  hice.  If the plural of man 
is always called men, Why shouldn't the plural of pan be called pen? 

"Teleo has great technology to deliver su-
perior VoIP quality and an excellent overall 
customer experience," said Blake Irving, 
corporate vice president of the MSN Com-
munication Services and Member Platform 
Group at Microsoft. 
Members of the Teleo executive team will 
continue to work closely with MSN follow-
ing the acquisition, and a number of Teleo 
product developers are expected to join 
MSN. 
 

What is VoIP? 
 

Voice over IP (also called VoIP, IP 
Telephony, Internet telephony, and 
has also been branded Digital 
Phone) is the routing of voice con-

versations over the Internet or any other IP 
network. The voice data flows over a gen-
eral-purpose packet-switched network, in-
stead of traditional dedicated, circuit-
switched voice transmission lines. 
 

Protocols used to carry voice signals over 
the IP network are commonly referred to  
as Voice over IP or VoIP protocols. 
 

Voice over IP traffic may be deployed on 
any IP network, including ones lacking a 
connection to the rest of the Internet, for 
instance on a private building-wide LAN. 
 
Taken from Wikipedia—http://en.w ikipedia.org  
 

(Continued from page 1) 
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If I spoke of my foot and show you my feet, A nd I give you a boot, would a pair be called beet? If one is a tooth 
and a whole set are teeth, Why shouldn't the plural of booth be called beeth? 

Helpful Hints 

Prevent Pictures From 
Moving In Word   

Dianna Huggins 
 
Have you ever inserted a picture into 
Word, placing it exactly where you want it, 
only to find out later that it is now in a dif-
ferent place? Well believe it or not, you do 
have complete control over where your 
picture is located and where it stays.  
If you are working in Word 2002 and later, 
use the steps below to position your 
graphic. 
1. Insert the picture into your document. 
2. Click the picture once so it is selected. 
3. From the Format menu, click Picture. 
The Format Picture dialog box appears. 
4. Click the Layout tab. 
5. Choose any of the available Wrapping 
options (except In Line With Text). 
6. Click the Advanced button. 
7. Verify that Picture Position is selected. 
8. Under Horizontal choose Absolute. Set 
the picture to be the desired number of 

inches to the right of Page. 
9. Under Vertical choose Absolute. Set 
the picture to be the desired number of 
inches below Page. 
10. Verify that the Move Object with Text 
check box is not selected. 
11. Close any open dialog boxes. 
If you are working with previous versions 
of Word, the steps are going to be slightly 
different. 
1. Insert the picture into your document. 
2. Click once on the picture to select it. 
3. From the Format menu, click Picture. 
4. Select the Position tab. 
5. Use the drop down arrow under Hori-
zontal to specify the desired number of 
inches from the Page. 
6. Use the drop down arrow under Verti-
cal to specify the desired number of inches 
from the Page. 
7. Clear the Move Object with Text box 
8. Close any open dialog boxes 
 
Submitted by: Greg Wilson 

What's the Big Deal about Photo-
shop's Layers? 
 
Imagine that you have three sheets of 
acetate -- you know, like folks used to 
slide into overhead projectors to bore au-
diences before the days of multimedia 
presentations. Anyway, on one sheet you 
draw a picture of a fish. On a second 

sheet, you draw a fishbowl. And on a 
third sheet, you draw the table on which 
the fishbowl sits. When you stack all the 
sheets on top of each other, the images 
blend together to create a seam-
less view of a fish in his happy 
home. 
 

(Continued on page 4) 
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Let's face it - English is a crazy language.  There is no egg in eggplant nor  ham in hamburger; Neither apple nor 
pine in pineapple.  English muffins weren't invented in England.  We take English for granted.  

 
 
 
 
 

THE COMPUTER SWALLOWED 
GRANDMA 

 
             

The computer swallowed grandma. 
Yes, honestly its true. 
She pressed 'control' and 'enter' 
And disappeared from view. 
 
It devoured her completely, 
The thought just makes me squirm. 
She must have caught a virus 
Or been eaten by a worm. 

  
I've searched through the recycle bin 
And files of every kind; 
I've even used the internet, 
But nothing did I find. 
  
In desperation, I asked Jeeves 
My searches to refine. 
The reply from him was negative, 
Not a thing was found 'online'. 
  
So, if inside your 'Inbox,' 
My Grandma you should see, 
Please 'Copy', 'Scan' and 'Paste' her 
And send her back to me! 
  
Author Unknown 
 
Submitted by: Y. Bulger 

Layers in Photoshop work just 
like that. You can keep differ-
ent elements of your image on 

separate layers and then combine the 
layers to create a composite image. You 
can rearrange layers, add and delete lay-
ers, blend them together using different 
opacity values and blend modes, and do 
all sorts of other impressive things. 

 
Another advantage of using layers is that 
you can edit or paint on one layer without 
affecting the other layers. That means 
you can safely apply commands or paint-
ing tools to one portion of your image 
without worrying about messing up the 
rest of the image -- and without bothering 
to select the element you want to edit. 
 
Submitted by: Greg Wilson 

(Continued from page 3) 
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But if we explore its paradoxes, We find that quicksand can work slowly, Boxing rings are square and A  guinea pig 
is neither from Guinea nor is it a pig.  A nd why is it that writers write but fingers don't fing, Grocers don't groce 
and hammers don't ham? 

By Brian Satterfield  
 

F eaturing a collection of programs 
we feel should find a home on any 
system--new or old. They run the 

gamut from applications that will safe-
guard you from the Internet's most dan-
gerous pests to those that will help you 
stay in touch with your friends and family.  
 
Since your new PC purchase may have 
left you temporarily short on dough, you'll 
be glad to know the lion's share of these 
programs is totally free, though we have 
included a few that will require a small 
financial commitment.  

 
Still, even if you download every one of 
these apps (and we suggest you do), you 
won't spend more than $150, small 
change considering how much safer and 
more capable your machine will be.  
 
Whether you're upgrading to your 10th 
computer or are pulling one out of the 
box for the very first time, don't go any 
further without downloading these 20 in-
dispensable programs. 
 
Go to:  
http://www.download.com/1200-20-5150151.html 
 
Submitted by: Gary Korpan  

10 TIPS FOR SAFER 
INSTANT MESSAGING 
 

Never give out sensitive per-
sonal information, such as your credit card 
number, social security number, or pass-
words, in an IM conversation. 
 

Only communicate with people on your 
Contact List or Buddy List. 
 

Never agree to meet a stranger in person 
whom you've met on IM. 
 
Never accept files or downloads from peo-

ple you don't know. Never accept files that 
you weren't expecting from people you do 
know. 
 

Each IM program assigns you a name, not 
unlike an e-mail address. This name is 
usually called a screen name. Choose a 
name that doesn't give away your personal 
information. For example, use SassySue 
instead of NanaimoSue. 
 

Monitor and limit your children's use of IM.  
 

Just like an e-mail address, don't post your 

(Continued on page 7) 
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 In what language do people recite at a play and play at a recital? Ship by truck and send cargo by ship? Have 
noses that run and feet that smell ? How can a slim chance and a fat chance be the same, While a wise man and a 
wise guy are opposites? 

HELP PREVENT  
IDENTITY THEFT 
FROM PHISHING 
SCAMS 
 

The dos and don'ts of dealing w ith  
suspicious e-mail 
Published: February 10, 2005 
 

M ost phishing scams are sent 
through e-mail. By following 
these guidelines, you can help 

protect yourself from these tricky scams. 
 

Do report suspicious e-mail. If you suspect 
you may have received phishing e-mail de-
signed to steal your identity, report the e-
mail to Anti-phising Working Group go to 
http://www.antiphishing.org/report_phishin
g.html 
 

If you think you've received a phishing e-
mail message, do not respond to it. 
Do be wary of clicking on links in e-mail 
messages. Links in phishing e-mail mes-
sages often take you directly to phony 
sites where you could unwittingly transmit 
personal or financial information to con art-
ists.  
 

Avoid clicking on a link in an e-mail mes-
sage unless you are sure of the destina-
tion. Even if the address bar displays the 
correct Web address, don't risk being 
fooled. There are several ways for con art-
ists to display a fake URL in the address 

bar on your browser. Do type addresses 
directly into your browser or use your per-
sonal bookmarks. If you need to update 
your account information or change your 
password, visit the Web site by using your 
personal bookmark or by typing the URL 
directly into your browser. 
 

Do check the security certificate when you 
are entering personal or financial informa-
tion into a Web site. Before you enter per-

sonal or financial information into a Web 
site, make sure the site is secure. In Inter-
net Explorer, you can do this by checking 
the yellow lock icon on the status bar as 
shown in the following example. 
 
Example of a secure site lock icon. 
 
If the lock is closed, then the site uses en-
cryption. 
The closed lock icon signifies that the Web 
site uses encryption to help protect any 
sensitive, personal information that you 
enter, such as your credit card number, 
Social Security number, or payment de-
tails. It's important to note that this symbol 

(Continued on page 7) 
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If Dad is Pop, how come Mom isn't Mop? A nd why do A mericans call their language English??? 

screen name online. People 
might find it and use it to 
send you unsolicited IM 

messages. 
 

Don't send personal or private instant mes-
sages at work. Your boss may have a right 
to view those messages. 
 

Most instant message programs allow you 
to automatically logon when you start-up 
your computer so that you don't have to 
enter your password every time you want 

to use the program. If you use a public 
computer, make sure not to configure your 
IM program for automatic logon. 
 

Be careful how you reveal when you're 
online or not. IM programs allow people on 
your contact list to see if you're available. 
However, using this feature may offer peo-
ple more information about you than you 
feel comfortable giving.  
 
Article published by: Microsoft 
 
Submitted by: Y. Bulger 

(Continued from page 5) 
 

doesn't need to appear on 
every page of a site, only 
on those pages that re-
quest personal informa-

tion. Unfortunately, even the lock symbol 
can be faked. To help increase your 
safety, double-click the lock icon to dis-
play the security certificate for the site. 
The name following Issued to should 
match the name of the site. If the name 
differs, you may be on a fake site, also 
called a "spoofed" site. If you're not sure 
whether a certificate is legitimate, don't 
enter any personal information. Play it 
safe and leave. 
 
Tip:  If you don't see the status bar at the 
bottom of your browser window, click on 
View at the top of the browser, and then 
select Status Bar to activate it. 
Don't enter personal or financial informa-

tion into pop-up windows. One common 
phishing technique is to launch a fake 
pop-up window when someone clicks on 
a link in a phishing e-mail message. To 
make the pop-up window look more con-
vincing, it may be displayed over a win-
dow you trust. Even if the pop-up window 
looks official or claims to be secure, you 
should avoid entering sensitive informa-
tion, because there is no way to check 
the security certificate. Close pop-up win-
dows by clicking on the red X in the top 
right corner (a "cancel" button may not 
work as you'd expect). 
 
Do update your computer software. As 
Microsoft, continues to make improve-
ments to our software to help protect our 
c o m p u t e r s .  V i s i t  g o  t o  
http://update.microsoft.com/w indow supdate 
to scan your computer and install any 
high-priority updates that are offered to 

(Continued from page 6) 
 

(Continued on page 8) 
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If teachers taught, why didn't preachers praught? If a vegetarian eats vegetables, what does a humanitarian 
eat? 

you. If you have XP 
then you can set your 
computer  to Automati-
cally update, the up-
dates are delivered to 

you when they are released, but you 
have to make sure you install all Custom 
updates yourself.  
 
For an eye opener to this  
problem go to: 

http://www.antiphishing.org/  
 
and read the up to date statistics regard-
ing this subject. 
 
Information published by the Microsoft  
Company— 
 
Submitted by: Y. Bulger 

(Continued from page 7) 
 

 
 
 
 

NIKON, KODAK RUSH  
WI-FI  DIGITAL CAMERAS TO 
MARKET  
Sept. 1, 2005 - www.techweb.com/ 
 
The wireless capability w ill allow photog-
raphers to share photos as soon as 
they're snapped, as well as beaming them 
to nearby printers. 
 

Eastman Kodak and Nikon are rushing 
Wi-Fi-enabled digital cameras to market 
in a race to  bring the first wireless Wi-Fi 
camera to photography enthusiasts.  
 

Initially announced in January, Kodak’s 
Easyshare-One zoom digital camera will 
be available in October. Nikon’s compact 
Coolpix P1 and P2 are scheduled to be 
available for purchase Sept. 15, Nikon 
said Thursday.  
 
Both companies are touting the capabili-
ties of their respective cameras to enable 
users to easily share photos immediately 
after they are snapped. Photos can also 
be transmitted directly to  printers where 
they can likewise be printed immediately.  
 
Nikon said the Wireless Print Adaptor for 
use with the cameras will be available in 
October.  
 

Submitted By: Y. Bulger 
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The End ………….. 

Wireless Services Returning 
After Massive Hurricane  
Disruption—By TechWeb News  
 
After police and rescuers spent days try-
ing to respond to Hurricane Katrina with-
out modern communication and Louisi-
ana Governor Kathleen Babineaux 
Blanco blasted wireless companies for a 
complete loss of services, connections 
were being restored along the Gulf Coast 
Friday.  
 

Verizon Wireless, based in Bedminster, 
N.J., reported Friday that it had restored 
wireless service in several areas, includ-
ing New Orleans’ airport. The company 
said it had also restored service to parts 
of Alabama and Florida.  

 

In a statement released Friday, Verizon 
said emergency crews had moved into 
areas that could be reached safely and 
they were working to restore wireless and 
landline connections.  
 

Stores and emergency call centers were 
beginning to serve people Friday. The 
company said people were more likely to 
successfully transmit  text messages than 
place regular calls.  
 

Some police had been relying on two-
way radio systems. Some reportedly 
even used people to run between work-
ers to send messages. Others had no 
means to communicate. By Friday, some 
lucky responders had received satellite 
phones.                        Submitted by:  Y. Bulger 

TAKE YOUR PIANO WITH YOU 
 

With this flexible silicon rubber piano key-
board that rolls up to fit into its own 7” 
travel bag. Quality 4-octave 49 key key-
board features 100 musical tones, 20 
rhythms and 10 built-in demo tunes. Fea-

tures include built-in speaker, external 
speaker and headphone jacks. Runs on 4 
AA batteries or AC adapter, both in-
cluded.  
 
www.computergear.com 
 

Submitted by: Y. Bulger 

Keyboard Key Caps 


